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COBOL-IT Developer Studio is COBOL-IT’s Integrated 

Development Environment.  

  

  
     The Developer Studio allows you to develop, debug and maintain your legacy  

     COBOL applications in a highly configurable project-oriented environment.  
  
     The COBOL-IT Developer Studio is integrated with the Eclipse framework.  

  

   

THE ADVANTAGES OF OPEN SOURCE IN COBOL-IT AND ECLIPSE 

The COBOL-IT Developer Studio is an Eclipse-based development environment.  

  
Eclipse is the most widely-used Open Source development environment framework and benefits from a mature 

toolset, a very well-developed knowledge base and broad portability.  

Using the Eclipse development framework, the COBOL-IT Developer Studio provides the ability to manage projects 

on every Windows/Linux/Unix platform on which the COBOL-IT Compiler Suite Enterprise Edition is available.  

With the Developer Studio, you can create COBOL Projects which you can Build, Run and Debug, both on local 

host machines and on remote host machines.  

   

AVAILABILITY  ON WINDOWS AND LINUX  

COBOL-IT provides the Developer Studio on all the major Windows and Linux platforms.  

  
With the addition of the Remote System Explorer, your COBOL projects can be located on any Unix, Linux or 

Windows platform, provided you have a COBOL-IT Compiler Suite Enterprise Edition installed on that platform.  

The Developer Studio will locate the COBOL-IT setup script on the host platform and use the host Compiler Suite 

for the key Build, Run and Debug functions.  

  

COBOL-AWARE CODE EDITOR    

      With its COBOL-aware Code Editor and its integrated Debugger, the Developer Studio enhances your ability to 
      develop and maintain your Legacy COBOL applications.  

  
The COBOL-IT Code Editor allows for the Colorization and Capitalization of Reserved Words.  

Configurable hot keys, pre-defined code fragments that can be inserted into the source by pressing a hot key, tab 

settings, line numbers, support for ANSI and terminal source formats and more.  

The COBOL-IT Code Editor will reduce the number of errors you make while coding and reduce the time it takes to 

correct them.  

The COBOL-IT Code Editor automatically produces an Outline View of your code which provides an easy clickable 

interface to your code at the level of the Division, Section, Variables and Paragraph.  
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POWERFUL DEBUGGER  

      The COBOL-IT Debugger provides for step into, step over, step return, run, terminate and disconnect functions.  

  
In a source-level interface, it also provides for the ability to manage conditional breakpoints, view the values of 

variables in Hex or ASCII format as well as monitor variables.  

The COBOL-IT Debugger can be configured to run with specific environment variables Including File Trace 

information and Memory  Dumps.  

When debugging code that has been pre-compiled, the Developer Studio can be configured to debug either the 

original source code or the source code generated by the pre-compiler.  

The COBOL-IT Debugger can be set to attach to a running process. With this capability, COBOLprograms that are 

called from other applications, such as transactional monitors, can be opened in the COBOL-IT Debugger. The 

COBOL-IT Debugger can then be detached from the running process when the debugging is complete.  

The COBOL-IT Debugger can switch between the host machine’s “C” debugger and the COBOL-IT COBOL 

debugger. This can be very useful when interoperating with programs written in “C”.  

  

  

REMOTE SYSTEM PERSPECTIVE        

     You may need to compile and test your application on multiple platforms.  

  
The COBOL-IT Developer Studio allows you to create Projects on remote machines. You can add existing source 

and data directories to your Remote Project, either by linking to the existing directory location directly, or by 

importing the directories into your Remote Project structure.  

Interfaces exist for initializing the COBOL-IT Compiler Suite Enterprise Edition installed on the remote machine, so 

that you can access the local resources in the same manner as if all the resources were located on your own local 

desktop.  

   

DATA DISPLAYER PERSPECTIVE  

Allows you to browse and edit data in indexed, relative, and sequential files using ASCII and Hex editors.  
  

The COBOL-IT Developer Studio provides the ability to open data files and display the contents in either Read-Only 
mode or in Read-Write mode. When open in Read-Write mode, the contents of the files maybe edited using either an 
ASCII or a Hex editor. The Data Displayer uses a data dictionary (XDD file) generated at compile-time to interpret 
the data contained in a file. Data Displayer can be opened on either a local or a remote host, and supports multiple 
record formats.  

  

  

CODE COVERAGE  

   Allows you to validate that all paths of code have been tested in a single, or series of run units    

  
   Code Coverage records which parts of your COBOL code are executed during a particular program launch.   

   Programs compiled with the code coverage compiler flag produce coverage information that is presented in the 

   Coverage view.  Source Code in the COBOL Code Editor is automatically decorated to demonstrate whether lines of 
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   source were executed or missed in the run.
    

PROFILER  

Allows you to view real-time memory and CPU usage, as well as statistical data on where your run unit 
spends elapsed time and CPU time.      

    
   Programs compiled with the profiling compiler flag produce profiling data that is presented in the Profiler View which    

   includes Runtime and Paragraph tabs.  In the Runtime tab, you have access to Memory and CPU usage, displayed 

   in real time.  In the Paragraph tab, you have access to paragraph-oriented statistical data, including number of times 

   entered, time elapsed, CPU time elapsed, external calls, and time elapsed in external calls.     
  

  

GIT PERSPECTIVE  

   Provides access the full range of functionality provided by the Git Source Code Control System.    
  
   The Git Perspective provides the ability to create a source code repository locally, or to access an existing source    

   code repository hosted on the web.  In addition to being the most widely-used open-source source code control 

   system, Git provides mechanisms to set triggers for automated test servers such as Jenkins operating in the DevOps 

   delivery cycle.  
  

RSEGIT PERSPECTIVE  

Allows you to work with existing Git repositories when operating in your Remote System Explorer Perspective.    
  
   Requires an RSE connection and an existing Git repository on the remote machine.  Users then have access to Git    

   functionailities from within their RSE connection.  
  

MYLYN TASK MANAGER  

 Allows you to manage tasks locally, or using web-based incident management systems.   
  

   Mylyn is the task and application lifecycle management (ALM) framework for Eclipse.  
   With connectors to popular issue management tools, Mylyn integrates other ALM tools into the Developer   

   Studio as well, allowing it to greatly enrich the developer’s experience.  
  

  

NEW INTERFACE FOR COMPILER FLAGS  

Provides access to more compiler flags, while presenting related compiler flags together.   
  

     Developer Studio 2.0.0 also includes an updated interface for managing compiler flags.  
    Updates have been made to the Window>Preferences>COBOL>Compiler, and   
    Project>Properties>COBOL Properties dialog screens.  Select the Enable source settings checkbox to 
    enable compiler flag and script settings.   
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COBOL-IT WEB SERVICES PERSPECTIVE  

    Provides Development Tools to expose COBOL functions as Web Services accessible through the Linkage Section   
  

   The COBOL-IT Web Services Perspective allows the Developer to map the POST, GET, PUT and DELETE 
   methods to COBOL functions and generate the intermediate components needed by a Client to access 
   the functions as COBOL-IT Web Services.  Intermediate components include an API string for use by the 
   Client and a  bridge program designed to capture the API string, and CALL the COBOL-IT Web  
   Service.  Bridge programs are generated from   templates, and as a result, the solution is highly adaptable.  
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COBOL-IT DEVELOPER STUDIO FEATURES AND BENEFITS  

  

  

FEATURE  BENEFIT  

  

Eclipse-based Development 
Environment  

  
Includes a Developer Studio Perspective for work on local projects, a Debugger 
Perspective for Debugging Tasks and a Remote System Explorer Perspective 
for working on projects located on remote machines. The COBOL-IT Developer 
Studio is certified on Linux and Microsoft Windows platforms.  

 
Highly Configurable Work Environment  

 Configure your workspace, populate your projects, set compiler flags and 
environment variables, build, and run the programs in your application. COBOL 
Compiler Flags and Environment Configuration can be done at the Workspace, 
Project, or Program level providing maximum flexibility.  

 
COBOL-Aware Code Editor  

 Create programming templates, program hot keys, colorize reserved words, 
operate in free, or ANSI source format. Easily identify and correct compiler errors. 
Operate with files and folders on local or remote platforms. The Code Assist 
features include support for folding and unfolding code at the Section and Division 
levels as well as the capitalization of reserved words.  

 
Remote Systems Perspective  

 Allows for the use of COBOL-IT Compiler Suites installed on remote machines. 
Allows for the use of Eclipse to create COBOL Workspaces, Projects and 
Programs on remote machines.  

 
Access External Utilities  

 Maximizes the flexibility and adaptability of the Development environment to the 
specific needs of the user.  

Powerful String Search functions that 
can be operated on the level or the 
Workspace from a selected directory 
including its subdirectories.  

 Allows programmer to quickly identify, and if necessary, modify all the 
occurrences of a given string, improving productivity.  

Allows programmer to refactor, so that when a variable name is changed, all 
usages of the variable name will automatically be changed as well.  

 
Outline View automatically generated 
from source code.  

 Provides clickable entry points to specific points in the program. Increases 
efficiency with which the programmer can navigate the full body of source code, 
increasing productivity.  

A Compiler Console View showing the 
output from the Build  

 Provides a very familiar view on the workings of the compiler, allowing for easy 
access to information about the state of the compile operation.  

 
Debugger support for EBCDIC-encoded 
programs  

 Enhances debugging capabilities. Makes full functionality of the newly licensed 
Dual-mode COBOL-IT Compiler Suite Enterprise Edition available in the 
Developer Studio.  

 
Debugger support for UTF-8 protocol  

  
Enhances debugging capabilities. Provides the ability to display values in Hex, 
and in UTF-8 in the Variable and Monitor windows.  

Debugger support for conditional 
breakpoints  

  
Reduces the time to isolate an error and correct it by allowing for breakpoints to 
be executed only when described conditions are met.  
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  Available for use with the Kepler and        
  Neon builds of Eclipse 

   

   The Kepler build requires the JRE 6 and later.  The Neon build requires the    
JRE 8 and later.   

 
Data Displayer Perspective  

   Supports the browsing of relative, line sequential and binary sequential     
files, and the browsing and editing of indexed sequential files.  Supports     
multiple KEYs, multiple RECORD formats, multiple START options.   

 
Code Coverage  

   Records which parts of your COBOL code are executed during a program    
launch.  Source Code in the COBOL Code Editor is automatically decorated    
to show whether lines of source were executed or not in the run.  

 
Profiler  

   Profiling data provides access to Memory and CPU usage, displayed in real    
time and to paragraph-oriented statistical data such as number of times    
entered, time elapsed, CPU time elapsed, time elapsed in external calls.  

 
Git Perspective  

   Provides access to the full range of Git functionality.  One of the most     
widely used source code control system, Git provides mechanisms to drive    
DevOps delivery with triggers for test automation servers like Jenkins.  
.  

 
RSEGit Perspective  

  Requires an RSE connection and an existing Git repository  
  on the remote machine.  Users then have access to Git functionailities in   
their RSE connection.   

 
MyLyn Task Manager  

  Mylyn is the task and application lifecycle management (ALM) framework for   
Eclipse.  With connectors to popular issue management tools, Mylyn    
integrates other ALM tools into the Developer Studio as well.  

 
New interface for compiler  flags  

  Updates have been made to the Window>Preferences>COBOL>Compiler,   
and Project>Properties>COBOL Properties dialog screens.  Select the   

Enable source settings checkbox to enable compiler flag settings.   

 
COBOL-IT Web Services Perspective  

  Allows the Developer to map the POST, GET, PUT and DELETE 
methods to COBOL functions and generate the intermediate components 
needed by a Client to access the functions as COBOL-IT Web Services.  
Intermediate components include an API string for use by the Client and a  
bridge program designed to capture the API string, and CALL the COBOL-IT 
Web Service.  Bridge programs are generated from templates, and as a 
result, the solution is highly adaptable.   

  
  Web Services sample applications  
 

  Web Services sample applications exist for the WildFly, Apache and Internet 
Browser solutions.  

    
   Web Services listener for Internet  
   Browser applications  
 

  xbind is a listener that can bew configured to listen on a port, receive an API 
string from an Internet Browser, and launch a COBOL-IT Bridge program.  
The COBOL-IT bridge program is designed to decode the API string, and call 
the COBOL-IT function selected for the API string. 

    
    Generate Web Services Bridge 
    Programs from Customizable  
    templates 
 

   Templates used to generate the Web Services Bridge Program are 
customizable.  As a consequence, it is easy to accommodate debugging 
information, or company-specific function calls.   

   
    Adaptable spring-resteasy.war file for 
    the WildFly solution. 
 

  The WildFly solution requires the deployment of a spring-resteasy.war file 
which can be adapted for your needs.   
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PLATFORM SUPPORT  

For the most recent information about Platform Support for the COBOL-IT Developer Studio, please reference the   
COBOL-IT Port List.  

  

About COBOL-IT 

COBOL-IT: From legacy to modernity  
COBOL-IT provides innovative and scalable solutions to enable enterprises to modernize their legacy COBOL 
applications.  Founded in 2008, this combination of products, processes and partners enables companies to support 
evolving needs and embrace continuous modernization.  A leader in the global COBOL community, COBOL-IT 
technology has migrated hundreds of customers, hundreds of thousands of users and hundreds of millions of lines of 
COBOL code.  
 
The COBOL-IT Solution today  
COBOL-IT supports the wider COBOL community with a comprehensive offering, including a robust and compact 
product suite, a high-quality, professional compiler, and a proven migration process – all created to preserve the 
functionality of strategic COBOL applications.  Endorsed by the globe’s most experienced migration partners, COBOL-IT 
has a strong track record in re-hosting mission-critical COBOL applications to open systems, and the Cloud.  COBOL-IT 
customers modernize legacy COBOL applications, and utilize best-of-breed open source solutions, cloud computing, big 
data and cognitive technology to maximize the benefits of DevOps practices. 
   
Partnership agreements between COBOL-IT and leading platform vendors, legacy modernization specialists, and 

software solutions in open systems ensure that moving to COBOL-IT can be accomplished rapidly, at low-risk, 

everywhere in the world. 

For more information, visit www.cobol-it.com  
Follow COBOL-IT on Twitter: https://twitter.com/cobol_it  
Click here to learn more about COBOL-IT products and services.  
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